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Understanding OpenGL
This document provides an overview of the OpenGL implementation in Red 3GL. For a 
complete list of supported cards and drivers, see the Installation Guide pdf on your Red CD-
ROM.

About OpenGL
OpenGL is a cross-platform standard for 3D acceleration. �GL� stands for �graphics 
library.� �Open� refers to the ongoing, industry-wide contributions to its evolution. 
OpenGL has been common in graphics workstations since 1992, and is built into both the 
Windows and Macintosh operating systems as well as a wide variety of display cards. 
However, OpenGL has only recently begun to make its way into video production. Boris 
Red 3GL represents the Þrst time that OpenGL acceleration is available inside most NLEs.

The technology behind OpenGL grew out of the desire to display high-quality 3D images 
as quickly as possible. SpeciÞc instructions for drawing geometry, textures, lighting, and 
special effects have been coded into the chips powering many graphics appliances, 
including game consoles, and many desktop computer display cards.

More details about OpenGL are available from http://www.opengl.org.

OpenGL and Boris Red 3GL
The bottom line is speed. Boris Red 3GL uses OpenGL to draw objects onscreen much more 
quickly than previous display technologies. In many cases, animations display even faster 
than real time. That�s because the images are displayed using software embedded in display 
hardware optimized especially for this task.

The Difference Between Video Processing and OpenGL

Because the needs of 3D content creators are different than the needs of nonlinear video 
editors, OpenGL and desktop video take very different approaches to displaying images. 
Video systems are optimized to display Þxed-size video images at a Þxed rate. While some 
specialized effects hardware can perform real-time operations on video, video editors have 
also relied on components built into their computers to perform additional processing for 
special effects, such as CPUs and RAM.

OpenGL processing, on the other hand, is performed entirely on the OpenGL card. CPU 
power, including multiple CPUs, RAM, as well as dedicated video processors, including 
real-time effects hardware, do no affect OpenGL performance. While some OpenGL 
hardware has the ability to share excess processing tasks to fast computer memory, it is 
critical for video editors to understand that the hardware in their systems may not be 
equipped for OpenGL processing.
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This is especially true of the hardware driving desktop computer monitors. Many computer 
display cards are designed to support large workspaces, but do not allocate any resources 
to drawing 3D objects, textures, or shading using OpenGL acceleration.

As a result, even the most current, state-of-the-art video systems may be missing the single 
component necessary to take advantage of OpenGL processing: the right display card. 
Fortunately, a wide range of reasonably priced cards is available to support the OpenGL 
acceleration in Boris Red. They are the same cards supported by the handful of NLEs that 
support OpenGL, as well as other graphics and 3D applications.

What are the requirements for OpenGL acceleration in Boris Red 3GL?

When started for the Þrst time after installation, Red performs a fast, automatic test to look 
for the speciÞc items below. If your conÞguration passes this internal test, Red opens with 
OpenGL enabled. If your conÞguration does not pass, an error message will appear with 
more speciÞc information. In that case, Red will open with OpenGL off by default, but you 
may elect to enable it yourself. Please see the next section for more information on how to 
work with unqualiÞed systems.

Clicking the Test OpenGL Hardware button in the Render tab of the Boris Red Preferences 
window also shows the results of the internal test. This is the recommended method for 
examining your system�s conÞguration.

Available Texture Memory
Greater than 32 MB of texture memory must be available to Red. As is typically the case with 
processing power, there�s no such thing as too much. More texture memory provides better 
performance, so if your budget allows a choice, go for the card with more texture memory.

The number we use in this context refers to the results of the OpenGL hardware test, rather 
than simply the amount of texture memory on your video card. For example, in some cases 
the Windows OS can make additional memory available, beyond what is installed on the 
card. In others cases, host applications reserve some texture memory. Because of this, 
different amounts of texture memory may be available in the plug-in and standalone 
components of Boris Red, resulting in different levels of performance.

Supported Hardware
•   ATI FireGL, Radeon (8000 up), Rage 128 (Macintosh only). The cards must NOT be TNT 

enabled. 

•   nVidia GeForce (any version above GeForce 2), Quadro

•   Matrox Parhelia

Software Settings
Macintosh OpenGL drivers are supplied by the operating system, which must 10.2.6 or 
later. Generally speaking, the latest drivers for Windows-compatible hardware are 
recommended, but be sure to check the Boris FX website for details.

Supported Hosts
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Currently all hosts are compatible with OpenGL in Boris Red except for Final Cut Pro 4. This 
is a limitation that Apple hopes to address in an upcoming maintenance release.

Please see http://www.borisfx.com/opengl for the latest updates to this information.

What if my card is not on the supported list?

Users with non-supported cards may still be able to get adequate performance, as long as 
those cards have more than 32 MB of available texture memory. 

For cards with less than this, OpenGL accelerated previews may still be available, with 
fewer cached textures available for preview. You also have the option to use OpenGL 
acceleration without any texture caching, which most systems will support.

In the small handful of cases where OpenGL acceleration causes conßicts with your display 
hardware, OpenGL may be disabled.

What are the consequences of trying to use OpenGL on an unsupported configuration?

Perhaps none at all. You may well Þnd the performance to be acceptable. The worst that 
typically happens is intermittent color ßashes or distorted frames, none of which will be 
present in Þnal renders. All these issues will go away when the resolution is set to High 
Quality or OpenGL is adjusted.

Can I have OpenGL available just when I need it and otherwise leave it off?

Absolutely! Simply work in High quality, at your chosen resolution. OpenGL accelerated 
previews will only engage when making adjustments, where redraw issues will be less 
distracting. 

For those cases that require precision even when making adjustments, simply press the Alt 
(Windows) or Option key (Mac), and all interactions will display in High quality. This 
behavior is set in the Preferences, on the Render tab, and can be reversed, so that all 
interactions are High quality by default, and the modiÞer key engages OpenGL accelerated 
previews.

How do I adjust OpenGL settings?

The amount of texture memory that Boris Red attempts to use may be adjusted in the 
Render tab of the Boris Red preferences. The OGL Acceleration menu offers the following 
options. Choose any option except Off to enter hardware OpenGL mode. You can also adjust 
this option by choosing Preview > OpenGL Mode and then choosing the appropriate option 
from the submenu.

•   Off disables the OpenGL hardware acceleration. This provides the slowest 
performance. When you choose Off, your system only offers software OpenGL 
acceleration. You should only choose this option if your system does not include a 
supported OpenGL card. You can use the Test OpenGL Hardware button to determine 
if your system includes a supported card. 
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•   On, no texture caching enables the OpenGL hardware acceleration but not the texture 
caching. 

•   On, some texture caching enables the OpenGL hardware acceleration and a limited 
amount of texture caching. Try this setting if the recommended setting generates 
garbage images.

•   On, Max. texture caching provides the best performance and is the recommended 
setting. OpenGL is only used for previews and interaction. None of these modes affect 
the Þnal output of your effect to disk, which is rendered at the highest possible quality.

How do I use OpenGL in Boris Red?

Simply open Red and begin working. While working in Draft Quality, everything displays 
to your monitor using OpenGL. Pressing the Space bar or the Play button on the Composite 
window provides OpenGL accelerated previews.

This is especially useful when building 3D animations, or even animating 2D objects such 
as video layers or still images. For example, you can animate the position and scale of a large 
image, and simply press the spacebar to see real-time playback of your pan and zoom 
animation.

What are the difference between OpenGL playback and Preview to RAM?

OpenGL playback is engaged when pressing the spacebar to play while in Draft Quality. 
Preview to RAM is obviously slower, but offers more accurate display and timing, as well 
as the ability to include audio with your previews. (OpenGL is a visual format and doesn�t 
include audio at all). Be sure to switch back to High Quality for the RAM Preview.

Again note the fundamental difference between OpenGL processing and traditional CPU 
and RAM processing. OpenGL previews are handled entirely by the accelerated hardware 
on your display card; RAM previews go through the same path to your computer�s CPU as 
the Þnal renders to disk. This is why RAM previews are slower on one hand, but more 
accurate on the other. The two kinds of previews provide two types of different tools, for 
two different tasks: speed and precision.

One more minor difference relates to the behavior of the Timeline window during previews. 
During RAM previews, rendered frames are marked in gray along the top of the window, 
and the CTI (Current Time Indicator) position updates to show playback progress. During 
OpenGL previews, no frames are rendered by the CPU, but rather by the graphics card, so 
no rendered frames are cached. It simply isn�t necessary, as OpenGL playback is faster than 
playback from frames cached in RAM. 

For similar reasons, the CTI does not update during OpenGL previews. The CTI is 
connected to CPU renders, and is not aware of OpenGL renders. Even if it were, OpenGL 
can display frames more quickly than the CTI could update. Tying the two together would 
slow down the OpenGL preview. Again note the difference between the purpose of 
previews in RAM and OpenGL, one to provide the most accurate possible previews, and the 
other to provide the fastest possible previews.
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How do I use the OpenGL interactors in the Composite window?

The default interactors are for Translate, indicated by handles with arrows at the end. 
Mousing over one of the handles turns yellow to indicate that you can click and drag to 
constrain the movement of the selected object in that direction (X, Y or Z). Clicking the 
object, but not directly on the interactor, allows free movement in any direction.

Press the E key on your keyboard to switch the interactors to Rotate mode, indicated by balls 
at the end of the handles. Again, dragging a handle constrains rotation to that axis, and 
clicking on the object, but not on the interactors, enables free rotation.

The R key enables Scale, indicated by squares at the end of the handles. 

W returns you to Translate mode, which is the default state of the interactors. G toggles the 
visibility of the interactors.

The W, E, R shortcuts for Translate, Rotate and Scale are standard in 3D modeling 
applications, but may also be changed using the customizable keyboard shortcuts feature in 
Boris Red, found in the Edit menu. The shortcuts for selecting these interactors are located 
in the Preview menu.

For more detailed information on using the OpenGL interactors, see Chapter 2 in 
Volume I of the Red User Guide.

Which aspects of Boris Red 3GL are accelerated by OpenGL?

OpenGL was created for the acceleration of 3D, which has always been a large part of the 
value offered by Boris. The most obvious place where users will see the advantages of 
OpenGL in Boris Red is therefore the creation and animation of 3D objects. This includes 
text, charts, vector shapes, and extruded Adobe Illustrator Þles. 

It also includes a variety of 3D primitives available inside Red, such as spheres, cubes, page 
turns, cylinders, and planes, including still images and video layers. All of these are true 3D 
shapes, in fully three-dimensional effects environments. They can be animated and played 
back in real time, or even faster on some cards. 

Additionally, static effects Þlters applied upstream in Boris Red are included in OpenGL 
accelerated previews.

Why do some elements of my compositions not display during accelerated previews?

Open GL was developed to optimize 3D. While no other compositing environment offers as 
many 3D creation options as Boris Red, Red offers much more than 3D. Red also offers 
advanced compositing, custom masking and image processing capabilities such as 
animated apply modes and Optical Flow, as well as motion tracking and 2D vector art. 
Software renderers still best handle all of these features.
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Even within the world of 3D, Boris Red offers a number of features that OpenGL cannot 
currently display in real time with the quality that Red users have come to expect. These 
include bump maps, reßection maps, certain kinds of lights, and cast shadows. OpenGL can 
display materials created in Red, intersecting and combined objects in a scene, and some 
lights, shadows and textures, but not yet the full range of 3D options available in Red.

Red also offers a variety of ways to combine those 2D compositing features with 3D objects, 
for an exceptional range of effects options. Again, this combination of compositing styles 
may sometimes exceed the current reach of OpenGL.

That�s true today, anyway. As the OpenGL standard evolves, look for a wider variety of 
effects to be accelerated. In the meantime, Boris Red combines the best of OpenGL speed for 
effects creation with exceptionally high-quality software rendering for the most ßexible 
approach to compositing and effects on the market.

What are the benefits of OpenGL when working in High Quality?

When building animations with elements whose display is not supported in OpenGL, you 
need to see every detail. That�s what High Quality is for, of course. However, you may not 
need to see every detail in your scene when moving speciÞc objects. OpenGL is 
automatically engaged when you interact with those objects, such as when scaling or 
positioning them, whether using sliders in the Controls window, values set in the Timeline 
window, or using interactors in the Composite window to move or scale the objects directly.

During these interactions, masks, bump maps, reßection maps, and downstream Þlters may 
be turned off to allow OpenGL accelerated previews. The High Quality software renderer 
takes over when you release the mouse, and all composition elements are visible.

There are times when you�ll need to see every detail while moving objects, of course. That�s 
easy � simply press the Option key on Macintosh or the Alt key on Windows while moving 
elements, and the display updates with every element displayed at High Quality, in the 
resolution that you�ve set.

You may also choose to reverse this behavior, so that interaction leaves all elements visible 
by default and only hides them when holding the modiÞer key, in the Render tab of the 
Preferences.

How much faster is OpenGL processing?

This is virtually impossible to quantify in any consistent way, because of the wide range of 
hardware conÞgurations and the wide range of effects it�s possible to create with Boris Red.

As noted earlier, some advanced 2D compositing effects do not beneÞt at all from OpenGL�s 
3D acceleration. A single layer of 2D texture, including video, may be accelerated only 
moderately, as 2D interactions in Boris Red are already quite speedy.

To show 30 frames per second, an individual frame must be drawn every 33 milliseconds. 
Even minimally qualiÞed systems are capable of speeds more like 20 milliseconds per 
frame, even on a multi-layer 3D animation with textures, lights and shadows that might 
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take 15-20 seconds to render at highest quality, representing a performance boost of 1000% 
or more in some cases. Again, this will vary dramatically depending on all of the variables 
mentioned above. The bottom line is that OpenGL provides a truly dramatic performance 
boost.

Does OpenGL accelerate final renders?

Not at this time. However, Boris Red 3GL offers a wide variety of render optimizations in 
virtually every area of the product. The time savings will be more dramatic on complex 
effects, but can be seen in effects using 3D extrusions, procedural textures, large images or 
frame sizes, a wide variety of Þlters, and composites that combine static and animated 
elements. Depending on the speciÞc effect, renders may be improved by 30% or more. See 
the Boris FX website for details.

Troubleshooting
My card is on the supported list, but I get an error message saying that my card isn�t 
compatible.

This is almost certainly a driver issue. Be sure to check the Boris FX website for information 
on the latest supported drivers.

In many cases, you�ll still be able to take advantage of OpenGL inside Boris Red 3GL, as 
discussed earlier in this document.

I have similarly conÞgured cards from the same vendor for Windows and Macintosh. Why is 
the performance on Windows so much faster?

The Windows operating system allows vendors to share fast system memory when there are 
more OpenGL textures than the card can draw by itself. Additionally, a heritage of 
competition among OpenGL card vendors has led to some speciÞc performance 
enhancements that are not possible in the current state of Macintosh development.

That said, OpenGL is a major focus of Apple�s development efforts in OS X, which is why 
we require the latest version of that OS. Coupled with increased competition for maximum 
OpenGL performance on that platform, the performance gap could well decrease in the 
future.

Why do I sometimes see different images in OpenGL previews than I do in High quality or in 
rendered output?

As discussed earlier, a number of advanced 3D elements such as bump maps, reßection 
maps and cast shadows cannot currently be displayed in Red�s OpenGL. accelerated 
previews. It is important to remember that OpenGL is currently best used for previews and 
to accelerate the building of effects. Effects should always be viewed in High Quality before 
they can be considered Þnished.
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Other elements that display quite easily in OpenGL require an additional step when 
working in High quality software renders. These include OpenGL�s ability to show shapes 
such as cylinders and page turns as true 3D objects, as well as intersecting shapes. 

To see the same thing in High Quality, you just need to place those objects inside a 3D Model 
container. In fact, objects inside 3D Model containers, including video layers, may now have 
the entire range of 3D attributes applied to them, including bump maps, reßection maps, 
intersections with cast shadows, and more. This is such an important feature that there is 
now a shortcut button on the timeline for nesting selected tracks into a 3D Model container.

Why do I see banding and reduced colors in the Composite window?

This is especially common on Windows systems that have less than 32-bit color set in the 
Displays Control Panel. Boris Red requires 32-bit color on both Windows and Macintosh.

Windows users with ATI boards will need to right-click their computer desktop and select 
Display Properties, select the Settings tab then click the Advanced button. This will bring up 
the dialog box for your video card's conÞguration. Click the OpenGL tab and set the Texture 
Preference to the maximum setting. If you do not have the option to set Texture preference 
to maximum you need to update the ATI Control Panel. It can be found with the drivers (as 
a separate download) on the ATI web site.

In addition ATI�s latest driver (listed on their website as Version: 6.14.10.6368 and in our 
OpenGL hardware test as version 6.14.10.3842) has a bug and does not support 32-bit color 
for textures at all. ATI users should use the driver listed on ATI website as 6.14.10.6360 until 
a newer driver is released that addresses this limitation. 

Why do I see white frames, purple frames, garbage frames and other distortions in the 
Composite window while trying to use OpenGL?

This is because your video card does not have enough texture memory to support the level 
of OpenGL you�re trying to use. Begin by reducing the amount of texture caching. If you still 
see problems, turn off texture caching, then turn off OpenGL if necessary, until you have the 
chance to upgrade your display card.

Why is my OpenGL performance slower on my second monitor?

Windows users with dual head display cards have two options for conÞguring their 
displays: Independent and Stretched. In Independent mode, each screen runs 
independently of the other. It allows only one screen to support OpenGL playback, typically 
the monitor with the OS menu bar. In Stretched mode, the monitors share one display and 
one resolution, allowing OpenGL playback from any part of the display.

Macintosh users with separate cards to drive each monitors will also need to leave the 
Composite window on the monitor where it was Þrst opened. This is because of the way the 
operating system manages OpenGL resources. To change monitors for the Composite 
window, move it to the desired monitor, and exit Red. The Composite window will support 
OpenGL playback in the new location in the next session.
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Why does the OGL Hardware test shows the wrong information for my Matrox G550 card?

The Matrox G550 driver will sometimes incorrectly tell us it is a G440 or G400. Regardless, 
we do not ofÞcially support any of those boards. The Parhelia is the only Matrox device 
supported for OpenGL in Red at this time.

Why do the CTI and RAM cache markers not update during OpenGL previews like they do 
during Preview to RAM? 

During RAM previews, rendered frames are marked in gray along the top of the window, 
and the CTI (Current Time Indicator) position updates to show playback progress. During 
OpenGL previews, no frames are rendered by the CPU, but rather by the graphics card, so 
no rendered frames will be cached. It simply isn�t necessary, as OpenGL playback is faster 
than playback from frames cached in RAM. 

For similar reasons, the CTI does not update during OpenGL previews. The CTI is 
connected to CPU renders, and is not aware of OpenGL renders. Even if it were, OpenGL 
can display frames more quickly than the CTI could update. Tying the two together would 
slow down the OpenGL preview. Again note the difference between the purpose of 
previews in RAM and OpenGL, one to provide the most accurate possible previews, and the 
other to provide the fastest possible previews.

Why do OpenGL previews move more slowly with the Info window open?

Among the features of the Info window is that it measures the time it takes for an individual 
frame to be rendered by the computer�s CPU. OpenGL previews are not rendered by the 
CPU but by the graphics hardware. However, the Info window will force renders to the CPU 
in order to display that information, effectively bypassing the accelerated OpenGL preview 
in favor of the slower, but more accurate, CPU render.

One reason why the Info window is not currently an adequate measure of how quickly an 
individual frame is rendered is that OpenGL is frequently capable of displaying full 
resolution frames faster than 30 times per second, certainly faster than the calculation time 
can be displayed. In other words, showing the OpenGL processing time is much slower than 
the actual processing! 
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